SHSD Email
Staff Email
SHSD uses GroupWise for email. Staff email can be accessed from any networked computer in the district. There is a GoupWise
Client that has been installed on most staff computers and is accessed by clicking on the GroupWise icon (blue world).
GroupWise is also available through the web by going to https://webmail.sweethome.k12.or.us. Your username and password
are the same as the username and password that you use to log on to the Novell server.
Note that both versions of GroupWise have excellent help available in the Help files in the program. There are many "How Do I"
subjects available.

Home Page
Working with Panels – GroupWise Desktop Version Only
To add a panel, right click on “Home” on the navigation toolbar (far left) and click on “Properties”
Click the “Display” tab.
Under “View By” choose Panels, “Customize Panels”. Here you can add panels, add items to panels, and change the order of
display items in the panels.
To add a new panel, click on the list of available panels in the left, and click “Add” to the section on the right, depending upon if
you want it to display in column one or column two. You may click on “Move Up” or “Move Down”.
You may also create a new panel here. Click “New Panel” and give it a name. I made one called “Inbox”. Below “Choose Folder
or Web Page”, click on “Change Folder”. I clicked on my “Mailbox” and clicked “OK”. Click “OK” again and it shows up in your
display of available panels, which you can then move to one of the columns listed on the right.
Click “OK” to indicate you are finished working with panels, or “Restore Defaults” to reset back to the default view.

How to Add a Signature to Your Email


To Add Your Signature to Items You Send – Web Version
o
o
o
o

In the GroupWise main window, click "Options" in upper right corner.
From Compose tab, check “Enable Signature".
Type your signature text in the box.
Click "Automatically Add Signature" to have GroupWise add the signature when you send the item.
or

o

Click "Prompt Before Adding Signature" to have GroupWise prompt you before adding the signature when you
send the item. If you select Cancel when prompted for your signature, the message is sent without your
signature.
Click Save.

When you create a signature, GroupWise WebAccess stores it in your GroupWise Mailbox at your post office. Whether
you log in to your Mailbox through GroupWise WebAccess or another version of the GroupWise client, you always have
the same signature.

To Add a Signature to Items You Send – Desktop Version
o
o
o
o
o
o

To specify a general signature for all items, click "Tools", "Options", and double-click "Environment".
Click the "Signature" tab.
Place a checkmark next to "Signature".
Type the text you want as a signature in the Signature box.
Click a signature option - "automatically add" or "prompt before adding".
Click "OK".

Working With GroupWise Attachments
GroupWise Desktop Version
Sending Attachments:



To add an attachment to your message, create a new message then click the paperclip icon on your toolbar, or press
Ctrl+L, or click "File", "Attachments", "Attach Files". Navigate to the location of the file you wish to send and click "OK".
Click "Send" to send your email.

Receiving Attachments:



If you right mouse click on the attachment, you have several options:








View attachment – GroupWise will use its own viewer to show the attachment
View in new window – GroupWise will use its own viewer and show the attachment in a new window
Open - GroupWise will try to open the attachment with the program it’s configured to open up by default.
Open With – GroupWise will allow you to choose the program used to open the attachment.
Save As – GroupWise will enable you to save the attachment in the location of your choice.
Print – Print the attachment to your printer of choice.

GroupWise Web Version
Sending attachments:



Click "New" and select "Mail". Address your message and type the subject line and body of the message. Click the
"Attachments" tab and click "Browse" to navigate to the file you wish to send. Click to select the file, and click "Open".
It should now show up in the "Select File" window. Click "Attach" to attach the file to your message. The file you attach
should show up directly under the Subject line of your email.

Receiving attachments:






View attachment – GroupWise will use its own viewer to show the attachment
Open - GroupWise will try to open the attachment with the program it’s configured to open up by default.
Save As – GroupWise will enable you to save the attachment in the location of your choice.
Print – Print the attachment to your printer of choice.

Working With GroupWise Notify
Setting Notify to Run Automatically
If you would like to be notified of upcoming new mail or calendar events that have arrived, you may configure GroupWise's
"Notify" feature to start automatically when you run GroupWise. In GroupWise, click the "Tools" menu and choose "Options".
Double-click "Environment" and place a checkmark next to "Launch Notify at startup". Click "OK". This will launch Notify the
first time you start GroupWise each day.
If you would like Notify to start each time you start your computer, go to the Start menu on the Windows taskbar, and choose
"Programs". Look for "Novell GroupWise" and expand it to see "Notify". Right-mouse-click on the word "Notify" and left click on
"Copy". On your Windows Desktop, double-click "My Computer". Double-click on the "Local Disk (C:)" to open it and doubleclick on the "Documents and Settings" folder to open it. Look for the folder with your Novell network login name on it and
double-click to open it. Likewise, open the folder named "Start Menu", then the "Programs" folder and lastly, the "Startup"
folder. Right-mouse-click and select "paste" from the menu which appears. This puts GroupWise Notify in your Start up group
so that it will start every time you start Windows.
By default, Notify will only monitor your Mailbox. To change it to include your calendar or other folders, once Notify is running,
right-mouse-click on the Notify icon in the bottom right of the Windows taskbar. It looks like a small globe. From the menu
which appears, click "Options". On the right, you can select as many folders as you would like. On this screen, you can also
adjust the amount of time the Notification window is displayed on your screen. Fifteen seconds is the default, but you might
find you'd like the window to stay on your screen a little longer. If so, increase the setting in the "Show Notify dialog for" 15
seconds to a higher number.

Working With GroupWise Appointments, Tasks, and Notes
GroupWise Desktop Version
To schedule an appointment for other users
Click the "New Appt" icon, or click the "File" menu, "New", "Appointment" or press Ctrl-Shift-A. Choose the recipients, type a
subject line, select the day and time. Type a note in the message body if desired. Click "Post" when finished.
To schedule an appointment for yourself [Posted Appointment]
Click the drop-down arrow next to the "New Appt" icon and select "Posted Appointment". Type a subject line, select the day and
time. Type a note in the message body if desired. Click "Post" when finished.
Posted appointments are placed in your Calendar on the date you specified. They are not placed in your Mailbox or in any other
user's Mailbox.
To schedule a reminder note for other users
Click the "File" menu, choose "New" and "Reminder Note" or press Ctrl-Shift-R. Choose the recipients, type a subject line if
desired, and select the date and time. Type a note in the message body if desired. Click "Post" when finished.
To schedule a reminder note for yourself [Posted Reminder]
From your Calendar, open a view with a Reminder Notes List (for example, the Day view). Double-click a date on the calendar
or double-click an empty space in the Notes section. Choose a date if necessary, type a subject line and the reminder note.
Click "Post".
Posted reminder notes are placed in your Calendar on the date you specified. They are not placed in your Mailbox or in any
other user's Mailbox.
To assign a task to other users
Click the "File" menu and choose "New" and "Task". Select recipients. Type the date you want the task to begin and the date
you want the task to be completed. Type a subject and choose the priority. Type a description of the task if desired. Click "Post"
when finished.
To assign a task to yourself [Posted Task]
In your Calendar, open a view with a Tasks List (for example, the Day view), double-click a date on the calendar, or doubleclick an empty space in the Tasks List. If you choose to double-click a date, make sure you click the drop down arrow next to
"New Task" and select "Posted Task". Type the date you want the task to begin and the date you want the task to be
completed. Type a subject and choose the priority. Type a description of the task if desired. Click "Post" when finished.
Posted tasks are placed in your Calendar on the date you specified. They are not placed in your Mailbox or in any other user's
Mailbox.

GroupWise Web Access Version
From your inbox, click the drop-down arrow next to "New" and choose one of the following: Appointment, Task, Reminder Note,
Posted Appointment, Posted Task, or Posted Reminder Note. Follow the instructions above for the appropriate selection, starting
with filling in the information or choosing the date.

Working With GroupWise Proxies
About Proxy
Use Proxy to manage another user's Mailbox and Calendar. Proxy lets you perform various actions, such as reading, accepting,
and declining items on behalf of another user, within the restrictions the other user sets.
Two steps must be completed before you can act as someone's proxy. First, the person for whom you will act as proxy must
grant you rights in the Access List in Options. Second, you must add that user's name to your Proxy List so you can access his
or her Mailbox or Calendar.
After these two steps are complete, you can open your Proxy List and click the name of the person you're proxying for
whenever you need to manage his or her Mailbox or Calendar. You can also manage the schedules of users and resources for
whom you have proxy rights by using the Multi-User Calendar view.
Assigning Proxy Rights to Another User
Use the Access List in Security Options to give other users rights to proxy for you. You can assign each user different rights to
your calendaring and messaging information. If you want to let users view specific information about your appointments when
they do a busy search on your Calendar, give them Read access for appointments.

The following table describes the rights you can grant to users.

This Right
Lets Your Proxy Do
This

Read

Read items you receive. Proxies cannot see your Contacts folder
with this or any other proxy right.

Write

Create and send items in your name, including applying your
signature (if you have one defined). Assign categories to items,
change the subject of items, and perform checklist options on
items.

Subscribe to My Alarms

Receive the same alarms you receive.

Subscribe to My
Notifications

Receive notification when you receive items.

Modify
Options/Rules/Folders

Change the options in your Mailbox. The proxy can edit any of your
Options settings, including the access given to other users. If the
proxy also has Mail rights, he or she can create or modify rules and
folders. This right allows a proxy to add, delete, and modify
categories.

Read Items Marked
Private

Read the items you marked Private. If you don't give a proxy
Private rights, all items marked Private in your Mailbox are hidden
from that proxy.

Sharing Folders
GroupWise Desktop Version
Creating a Shared Folder
o
o
o
o
o
o
o
o
o
o

Click once on Cabinet so it is highlighted.
In the Folder List, click File, New, Folder.
Select Shared folder, then click Next.
Type a name and description for the new folder.
Click Up, Down, Right, or Left to position the folder where you want it in the Folder List, then click Next.
In the Name field, start typing the name of the user. When the user’s name appears in the field, click Add User
to move the user in to the Share List.
Select the access options you want for the user.
Repeat for each user. When done adding users, click Next.
Specify the display settings for the folder (most users just take the default settings).
When done, click Finish.

Accepting Shared Folders
o Click the Shared Folder Notification in your Mailbox. A screen appears, showing the name of the folder you
have been granted rights to and the type of rights you have been given.
o Click Next. The name of the folder is filled in by default. Make any desired changes to the name.
o Use the Up, Down, Left and Right buttons to select the folder’s location.
o Click Finish.

Deleting a Shared Folder
o Right-click on the folder.
o Click Delete, then click Yes.
Deleting a folder that is shared with you just deletes the folder from your GroupWise Mailbox. All other users are
unaffected. However, if you are the one who shared the folder with others, then deleting that folder removes it
from all other users as well.

Creating a Vacation Rule
o Click Tools, Vacation Rule.
o Select whether you want to activate the rule.
o Type a subject for the automatic reply.
Subjects appear in parentheses after the original message subject in the reply. For example, if the subject was
“Out of Office reply” and the message “Budget monitoring” was sent to you, the Auto Reply feature returns the
subject “Re: Budget monitoring (Out of Office reply).
o
o
o
o

Type the message that you want to appear in the automatic reply.
Select whether you want to reply to emails from outside you internal network.
Specify the dates when the rule will go into effect and when it will end.
Click Save.
Rules that trigger a reply (such as this vacation rule) keep a record of who a reply has been sent to, and make
sure that a reply is sent only once to that user.

Assigning A Category (different colors) to Any Item Type
To assign a category to a message, appointment, task, note or contact:
o Right-click on the item.
o Click Categories.
o Click a category in the drop-down list.
or
If the category you want isn’t listed, click More to display the Edit Categories dialog box, select the category,
then click OK.

To assign a category to an address book entry:
Open a personal address book.
Locate the user you want.
Right-click the user.
Click Details, the click Categories.
o Click a category in the menu, then click OK.
o
o
o
o

To add a new category:
Click Actions, Categories, More, to display the Edit Categories dialog box.
Type the category name in the New Category field at the bottom of the Edit Categories dialog box.
Click Add. The Add button becomes active when you begin typing a category name.
To assign a color to a category, select the category name in the list, then select the text and background
colors.
o Click OK to save the new category.

o
o
o
o

